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GIF Construction Set for Windows is shareware. If you like it, please register it. The 
registration fee for this application is $20.00 (US) plus $5.00 (US) shipping. Registering 
this shareware will ennoble your spirit, grant you excellent karma and provide you with 
technical support should you require it. We'll also send you the current version of this 
software on disk and evaluation copies of some of our other applications. No animals 
were harmed in the creation of this software. Recycle where required by law. Use no 
hooks.

We are:

Alchemy Mindworks Inc.
P.O. Box 500
Beeton, Ontario
CANADA
L0G 1A0



Also, please note that should you fail to support this program and continue to use it, a 
leather-winged demon of the night will tear itself, shrieking blood and fury, from the 
endless caverns of the nether world, hurl itself into the darkness with a thirst for blood on 
its slavering fangs and search the very threads of time for the throbbing of your heartbeat.
Just thought you'd want to know that.

___________________________________________________________________

You can have your registered copy of this application shipped to you on CD-ROM, rather 
than on 3½ inch floppy disks, at no extra cost. The CD-ROM also includes shareware 
evaluation copies of all our other applications, a library of useful Frequently Asked 
Questions documents, example graphics from our graphic CD-ROM collections, a gallery of
web graphics and a library of fifty royalty-free high resolution colour photographs courtesy 
of IMS Communications. 

Just select CD-ROM on the order form installed with this package or tell our operator that 
you want your software shipped on CD-ROM when you call our order desk.

The availability and contents of the CD-ROM are subject to change without notice -- the 
lawyers made us say that.

___________________________________________________________________

Toll-free registration and ordering is available from Canada, the United States, 
Britain and Australia. We can accept Visa, MasterCard and American Express. Call 
1-800-263-1138 from Canada and the United States. Call 0800-89-7355 from Great 
Britain. Call 1-800-554-082 from Australia. Please note that our operators are only 
able to handle credit card orders -- they cannot provide you with technical support, 
customer service or order status. They are unable to transfer your call or take 
messages. Callers from other countries can reach the order desk at 1-905-936-9500.

___________________________________________________________________

If you like GIF Construction Set for Windows, be sure to check out Graphic 
Workshop, GrafCat for Windows, GraphSaver, QuickShow Light and the other 
Alchemy Mindworks shareware applications. See the end of this document for more 
information.



Check out our web page at http://www.mindworkshop.com for the current shareware 
versions of all our software.

Register this software on CompuServe at GO SWREG. The registration code is 
10595 for the sixteen-bit version and 13375 for the 32-bit version. 

The GIF Construction Set Frequently Asked Questions document will help you if you 
have questions about this software. A copy was installed with GIF Construction Set -- see
our web page, above, for the most current version.

The Terms and Conditions document installed with this software includes a 
complete discussion of our ordering policies, license agreement and other matters 
which pertain to your use of this software. Check it out -- no salesmen or lawyers 
will call.

Avoid Having Your Heart Ripped Out
In addition to sending our leather-winged demon of the night down to your digs to snack 
out on important parts of you should you fail to register this software, we are also 
prepared to do so if you contact us for technical support and ask questions which are 
answered in this document. We spent a lot of time writing this thing, and pretty well 
everything you should need to know about using GIF Construction Set for Windows  is in
here. Please consult it before you get in touch with us.

In addition, you might want to consult our Frequently Asked Questions document for GIF
Construction Set. The current version of this file in included with the GIF Construction 
Set software – you can always find the most up to date one at our web page.

One of the things that really enrages our leather-winged demon of the night is people 
asking why their 256-colour GIF files won't display correctly through a sixteen-colour 
Windows display driver. See the section on the About dialog later in this document to 
pass on being turned into demon chow over this.
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Introduction
GIF Construction Set for Windows is a powerful collection of tools to work with 
multiple-block GIF files. It will allow you to assemble GIF files containing Image blocks,
Plain Text blocks, Comment blocks and Control blocks. It includes facilities to manage 
palettes and merge multiple GIF files together. It will make the extensions of the GIF 
specification work for you. Among its other functions, GIF Construction Set for Windows
can:

- Create looped GIF animations for Netscape.
- Create transparent GIF files.
- Create interlaced GIF files.
- Add, edit and delete comment blocks.
- Add non-destructive text to images as plain text blocks.
- Create multiple-image GIF files.
- Serve as a fully-compliant Windows GIF viewer application.
- Be a GIF viewer "helper" application for a World Wide Web browser or Mosaic client.

You can use GIF Construction Set for Windows to create and modify GIF files with as 
many blocks as you require.

GIF Construction Set for Windows  requires a minimum of four megabytes of memory to 
run reliably, with eight megabytes preferable. Larger images may require more memory 
still.

Blocks in GIF Files
A GIF file usually consists of two blocks, to wit, a Header and an Image. However, the 
structure defined by the GIF 89a specification allows for GIF files which contain multiple
images, and several additional optional block types. These types are:

- Comment blocks, which can include text describing the image in question, defining its 
creator or copyright status or anything else you want to say about it. Comment blocks are 
not displayed as part of a GIF file.

- Plain text blocks, which specify text to be overlaid on an image. The position and 



colour of the text can be defined. Unlike merely adding text to an image with a paint 
program, plain text blocks don't damage the underlying image.

- Control blocks, which define image transparency and allow for user input. The 
transparency field of a control block will let you specify that one colour in an image or a 
colour used by the text in a plain text block is to be regarded as transparent by a GIF 
viewer, allowing the underlying image to be visible wherever it occurs.

- Application blocks, which allow private application data to be included in a GIF file. 
Application blocks can't be created or edited with GIF Construction Set for Windows , 
although they will be preserved if you open a GIF file which contains them.

- Loop blocks, which define looping for multiple image GIF animations to be used with 
web pages. These are actually specialized application blocks.

- Block name blocks are also specialized application blocks, and are specific to GIF 
Construction Set. They hold the names of the image blocks in a GIF file.

Every GIF file begins with a Header block, which defines the size of the screen the GIF 
files should be displayed on if possible, and an optional global palette. It's important to 
understand how palettes work in GIF files. A palette defines the colours to be used by any
images and plain text blocks in a GIF file. A global palette, defined by the header block 
of a GIF file, pertains to all the images in the file. Alternately, individual image blocks 
are permitted to have palettes of their own, called local palettes. 

Because most display devices are colour mapped, and can only work with one palette at a
time, attempting to display multiple GIF images, each with its own local palette, will 
usually leave you with something that looks like bad abstract art or the aftermath of an all
you can eat spaghetti dinner. As such, multiple image GIF files should have all their 
images referenced to the global palette of the file unless you have a compelling reason to 
do otherwise. GIF Construction Set for Windows  includes facilities to remap and dither 
images to a global palette.

GIF Construction Set for Windows will let you open an existing GIF file or create a new 
one and add blocks, modify the various data fields of blocks and delete blocks. In the 
case of image blocks, it offers a number of image processing options to make assembling 
multiple image GIF files from a number of discrete images as practical as possible.

Running GIF Construction Set for Windows  
When you initially boot up GIF Construction Set for Windows , you'll see a list of all the 
GIF files in the \GIFCON directory of your hard drive. You can open a GIF file either by 
double clicking on one of the names in the list, or by selecting Open from the File menu. 
You can navigate to a different directory or drive either by double clicking on the drive 
and directory entries in the list of the GIF Construction Set for Windows application 
window or through the File Open dialog. 



If you click once on the name of a GIF file which has a Graphic Workshop thumbnail 
associated with it, you'll see a small version of the GIF file's first image in the application
window of GIF Construction Set for Windows. Thumbnails will be discussed in greater 
detail later in this document.

When you open a GIF file, the main application window of GIF Construction Set for 
Windows will list each of the blocks in the GIF file, beginning with the header. Clicking 
once on an image block will display a thumbnail for it. Double clicking on any block that 
GIF Construction Set for Windows  recognizes will call up a dialog to edit it. You can 
also edit a block by clicking on it once to select it and then clicking on the Edit button in 
the GIF Construction Set for Windows  button bar.

GIF Construction Set for Windows  does not allow application blocks or blocks of 
unknown types to be edited.

Editing the Header Block
You can modify the following fields of the header block of a GIF file:

- Screen width and screen depth: These are the dimensions in pixels of the screen the 
GIF file would like to be displayed on. They can be any value greater than zero. Note that
the screen dimensions do not affect the dimensions of images displayed from a GIF file, 
but they may affect where on your screen the images are placed in a fully compliant GIF 
viewer. For GIF files destined for web pages, these fields should define a rectangle which
just encloses all the other elements in your file. Left to its own devices, GIF Construction
Set will set these fields correctly each time you save a file.

- Background: The background is the colour of the area around the images to be 
displayed if the images in question don't fill your screen. The background is actually a 
number drawn from the current global colour palette... if the palette is changed, the actual
colour displayed may change too. To change the background colour, click on the colour 
button in the Edit Header dialog and select a new colour. The number in the Background 
colour button is the actual palette index being used.

- Global palette: The global palette flag tells GIF viewers whether a GIF file includes a 
global palette. If you change this flag, GIF Construction Set for Windows will look at the 
GIF file you're working on to see if there are images which expect a global palette and 
prompt you accordingly. In most applications of GIF files, it's desirable to have a global 
palette.

You can save palettes from GIF Construction Set for Windows to disk files and load them
in as new global or local palettes. The size of the current palette is shown to the right of 
the Load button.

The Sorted flag of Edit Header box allows you to set the state of the sorted palette flag in 



the header of GIF files. This flag has no affect on how GIF Construction Set for Windows
displays images – it may be of importance to other applications which read your GIF 
files.

When you create a new GIF file, a header block will be created automatically. The colour
depth is set by the Default Colour Depth item in the GIF Construction Set Setup dialog. 
This value can subsequently be modified by loading a palette with a different colour 
depth.

See the section of this document that deals with Palette Editors for more about the Edit 
button.

Editing Image Blocks
The Edit Image dialog includes the following fields:

- Left and top: These fields determine where the image in question will be displayed on 
your screen relative to the upper left corner. The values are in pixels. 

- Interlaced: This flag determines whether the image in question will be stored interlaced
or normally. If you have enabled the Display Interlaced item in the Setup dialog this will 
affect how GIF Construction Set for Windows displays images. It will also change how 
images appear in applications which display them one line at a time. Interlaced images 
are commonly used in World Wide Web pages.

- Local palette: You can enable a local palette for any image block in a GIF file. By 
default, the palette for the image in question will be used. You can also load and save 
palettes, as in the Edit Header field. Be careful doing this... you might wind us with an 
image having very weird colours. The Load and Save buttons will only be active if you 
have switched on the local palette option. The number of colours in the current image 
palette will be displayed below the Local Palette switch.

The View button of the Edit Header dialog will display the image in question. 
Specifically, it will display it against a solid colour background – grey by default – with a
set of purple guides indicating where the screen area defined by the screen width and 
screen depth fields of the current header block would fall. This assumes that your screen 
area and image are smaller than your screen. The background colour can be defined 
through the GIF Construction Set for Windows Setup dialog, discussed elsewhere in this 
document. 

Note that the View buttons in the edit dialogs will not display an entire complex GIF file. 
They'll only display the current block. If your image does not display correctly, please 
read the section of this document that deals with the About dialog for a discussion of 
Windows screen drivers. Hit Esc or click the right button of your mouse to exit the View 
mode.



See the section of this document that deals with Palette Editors for more about the Edit 
button.

The Paint button in the Image block editor  for the 32-bit build of GIF Construction Set 
will let you edit the image associated with an Image block. You can do anything from 
touch up a few pixels to paint an entirely new image. If you click on this button, a paint 
application -- the Windows Paintbrush package by default -- will open and let you make 
changes to your graphic. When you save your image and exit the paint application, your 
edited graphic will replace the original image associated with the block in question.

The Paint button may be disabled if GIF Construction Set thinks that Windows 
Paintbrush isn't capable of editing your image. It does this, for example, if your current 
Windows screen driver has less colour depth than your image does. Under Windows 3.1, 
the Paint button will only be active if your current Windows screend river supports more 
than 256 colours, as the sixteen-bit Windows Paintbrush application often makes a mess 
of graphics if it's running under a sixteen- or 256-colour screen driver. See the section of 
this document that deals with Setup for more about this.

It's important that you not change the colour depth or the colour palette of an image while
it's being edited.

Note that due to limitations of Windows 3.1, the Paint function is not available in the 
sixteen-bit build of GIF Construction Set.

Editing Comment Blocks
A comment block consists entirely of text. The Edit Comment Block dialog is a text 
editing window in which you can add, modify and delete the text of a comment block. 
Under GIF Construction Set for Windows , a comment block can include up to 32,767 
characters.

The Format button of the Edit Comment Block dialog will toggle between displaying text
in the conventional chunky Windows font and displaying it in a monospaced font. The 
former is better for editing a lot of text, while the latter is useful if you'd like to create 
formatted comment blocks.

Editing Plain Text Blocks
Plain text blocks consist of text and some information about how to display it. The text 
can be edited the same way comment block text is handled. The following fields define 
how plain text blocks will be displayed:

- Text left and text top: These fields define where the text will appear on your screen, 
relative to the upper left corner of the viewing area. These values are defined in pixels.

- Grid wide and grid deep: These fields define a rectangle in which your text will be 



drawn. A grid ten wide and twelve deep would allow for twelve lines of up to ten 
characters each. Text which doesn't fit in the grid defined by a plain text block is not 
displayed.

- Cell wide and cell deep: These fields define the dimensions of the characters used to 
display text. In theory, a GIF viewer should look at these fields and create a suitable 
monospaced font to display the text in question. In most cases this is not so – GIF 
Construction Set for Windows included. Most GIF viewers will use a font which is eight 
pixels wide and anywhere from eight to 32 pixels deep.

- Foreground and background: These are the colours used to display the text in 
question. Note that if a plain text block is preceded by a control block which defines a 
transparent colour, one of these colours can become transparent. You can select these 
colours either by clicking on their colour buttons or by using the eyedropper tool to pick 
colours from the previous image block if one is present. The eyedropper tool will not be 
active if there is not at least one image block before the current plain text block.

- Block title: This item will be enabled if the Write Directory Block item in the Setup 
dialog is checked. If you enter some text in this field, it will apear in the IMAGE line 
corresponding to the block in question in the main window of GIF Construction Set. By 
default this field will contain the name of the file from which the image was drawn if you
imported the image with GIF Construction Set.

The View button will display the image preceding the plain text block being edited with 
the text in question superimposed over it. Note that the View buttons in the edit dialogs 
will not display an entire complex GIF file. They'll only display the current block. If your
image does not display correctly, please read the section of this document that deals with 
the About dialog for a discussion of Windows screen drivers. Hit Esc or click the right 
button of your mouse to exit the View mode.

Editing Control Blocks
A control block includes the following fields:

- Transparent colour: If this switch is turned on, one of the global palette colours in 
subsequent image or plain text blocks will be regarded as being transparent by GIF 
Construction Set for Windows when you view a complete GIF file. This means that rather
than displaying areas of this colour, it will allow whatever is underneath the displayed 
image or text to show through. You can select this colour either by clicking on the colour 
button to the right of the switch or by using the eyedropper tool to pick a colour from the 
next image block if one is present. The eyedropper tool will not be active if there is not at
least one image block after the current plain text block.

- Wait for user input: If this switch is turned on, a GIF viewer displaying your GIF file 
will display the next image or plain text block and pause for user input. User input is 
usually a key press or a mouse click.



- Delay: This is the number of 100ths of a second a GIF viewer will pause after 
displaying the next image or plain text block. If Wait for User Input is also enabled, the 
delay can be interrupted by a key press. 

- Remove by: This tells a GIF viewer what do with an image after it has been displayed. 
Be careful of the Previous Image option... some GIF viewers have problems with this if 
you ask a really big image to be removed this way.

The View button will display the image preceding the control block being edited with any
transparent effects that you've defined. Note that the View buttons in the edit dialogs will 
not display an entire complex GIF file. They'll only display the current block. If your 
image does not display correctly, please read the section of this document that deals with 
the About dialog for a discussion of Windows screen drivers. Hit Esc or click the right 
button of your mouse to exit the View mode.

Editing Loop Blocks
A loop block includes one field, to define the number of times the images in the GIF file 
in question will repeat. Note that a Loop block will always appear as the second block in 
a GIF file, no matter where you insert it. Only one Loop block can appear in a GIF file.

Palette Editors
The Header and Image block dialogs include facilities to edit the palettes of their 
respective blocks. This can be a very powerful feature or a very destructive one, 
depending on whether you understand what it's up to.

Every pixel in a GIF image is drawn in one of the colours in the image's palette. If you 
change the colour of one of the palette entry, all the pixels referenced by that palette entry
will change. 

In a multiple-image GIF file with a global palette, changing the colour in one palette 
entry in the global palette will change the colour of all the pixels referenced by that 
palette entry in all the images in the file.

Be warned -- this can be a bit messy if you're not careful.

Inserting Blocks
You can add blocks to a GIF file with the Insert button of the GIF Construction Set for 
Windows button bar. A dialog will appear to allow you to select the type of block you 
wish to insert. Inserted blocks are always inserted immediately after the currently 
selected block. 

If you attempt to insert an image block into an existing GIF file, a dialog will appear 



prompting you for the file to insert. Images can be drawn from files in the following 
formats:

PNG These are compressed graphics created to replace GIF
PC Paintbrush PCX The native file format of Z-Soft's PC Paintbrush software
CompuServe GIF Among the most widely used PC image file formats
Truevision Targa Supports all Targa files
Windows /OS2 BMP Supports all BMP files, including those from OS/2
JPEG JPG All JPEG files will be displayed in 256 colours

You can insert multiple images into a GIF file at once – each one will appear as a separate
Image block. Select multiple images in the Open dialog by holding down the Ctrl key and
clicking on each image you want to insert. Hold down the Shift key and click to select a 
range of images.

Note that if you import an image from a GIF file using the Insert function, the first image 
in the file will be read, even if the file actually contains multiple images. Use the Merge 
command of GIF Construction Set for Windows, discussed later in this document, for an 
alternate approach to importing images from GIF files.

If you attempt to insert an image which has a different palette from the current global 
palette of your GIF file, a dialog will appear asking how you'd like to handle the new 
image's palette. These are the available options:

- Use a local palette for this image. If you do this, no colour shifts or dithering effects 
will be introduced into the image, but very nasty things may happen if you attempt to 
display this image concurrently with other images in the file. You can't use plain text 
blocks with local palette images. Local palettes are usually not a very good idea for 
conventional display applications. If you attempt to import a true colour image with this 
option, it will be dithered to a 256-colour image internally.

- Use a local grey palette for this image. The image will be converted to grey scale and 
installed with a local palette. All of the foregoing considerations for local palettes still 
apply.

- Remap this image to the global palette. This is a good choice for mechanical images...
drawings and such... and a really bad choice for photographs. Each colour in the source 
image will be replaced by the closest match from the global palette. This will usually 
make photographs look posterized.

- Dither this image to the global palette. This is a good choice for photographs. It will 
give you the best colour match... and usually the most attractive results... with a slight 
loss in detail resolution.

- Use this image as the global palette. This option will only be available if no other 
image blocks currently exist in your GIF file, such as when you create a new file. The 
global palette for the header of the file will be drawn from your imported image. If you 



attempt to import a true colour image with this option, it will be dithered to a 256-colour 
image internally.

- Use it as is. No checking or correction will be performed, and the colours in your 
imported image will fall where they may. This option is useful if you know that certain 
colours in your imported image correspond to colours in the current global palette, such 
as for images created to be overlays with transparent colours. Plan on radical colour shifts
and Andy Warhol's worst nightmare if this is not the case.

If you insert other types of blocks... specifically control, comment or plain text blocks... 
default blocks will be created which you can subsequently edit, as has been discussed.

The Use This Selection for Subsequent Images option will save time if you're importing 
multiple images into a GIF file in one pass. It will apply the current selection in the 
dialog to the remainder of the images to be imported. Note that this item will not be 
enabled if you have selected Use This Image as the Global Palette, as a GIF file can only 
have one global palette.

See the section elsewhere in this document on Inserting Images through Drag and Drop 
for an alternate technique for inserting Image blocks.

Merging Blocks
The Merge feature in the GIF Construction Set for Windows File menu will allow you to 
import all the blocks in a GIF file... except for the header block... into the current file. 
They will be inserted starting just after the currently selected block. Image blocks will be 
handled using the same logic discussed previously for inserting individual image blocks...
a dialog may appear prompting you to choose a strategy for handling palette conflicts.

You can use the Merge function to import selected images from a multiple-image GIF 
file. Merge the whole file and delete the blocks you don't need.

Extracting Blocks
The Extract feature in GIF Construction Set for Windows will allow you to select one or 
more blocks in an existing GIF file and have them written out to a new GIF file. GIF files
created by Extract must contain at least one Image block – the Save button will not be 
active until at least one Image block is selected. The Header block will automatically be 
adjusted to define a rectangle that encloses the images in the extracted file. The other 
parameters of the new Header block will duplicate those of the source Header block.

If you select more than one Image block and enable the Numbered option, Extract will 
create multiple numbered files, each with one image in it. The file names will consist of 
your destination file name with sequential numbers appended to it. For the Windows 3.1 
version of GIF Construction Set, note that as file names cannot exceed eight characters, 
you must supply a file name which is short enough to allow for the numbering or GIF 



Construction Set will complain.

Deleting Blocks
You can delete any block save for the header by selecting it and clicking on the Delete 
button. Note that once a block is deleted, it's gone for good.

Managing Blocks
The Manage function in the Block menu will let you globally change the Control blocks 
in your GIF files. It's useful for adding lots of Control blocks at one time, deleting lots of 
Control blocks without wearing your mouse down to a puddle of molten plastic and for 
changing the characteristics of lots of Control blocks.

Depending on the options you select, the Manage function's file selector will deal with 
Image or Control blocks. Specifically:

Insert Before Selected Images: This option will insert a new Control block before each 
of the selected Image blocks.

Insert Where Required: This option will insert a new Control block before each of the 
selected Image blocks which is not presently preceded by a Control block.

Set All Existing Controls: This option will change the parameters of each of the selected
Control blocks. Note that this pertains to all control blocks, even if they precede Plain 
Text blocks, rather than Image blocks.

Delete Selected Controls: This option will remove all the selected Control blocks. No 
other blocks will be affected.

Image Block Position options: This section allows you to set the Left and Top fields of 
all the selected image blocks. If you enable the Absolute option, all the blocks will be set 
to the values specified in the two spin button fields. Otherwise, the left and top values 
will be incremented by the values in the spin button fields, beginning with the left and top
values for the first selected block.

Note that if you click on the titles for the spin button fields when the Absolute switch is 
not enabled, they'll change, allowing you to decrement the initial values as well. These 
fields cannot have values less than zero.

Note that you can only select Control and Image blocks in the file selector list for the 
Manage function. You can select multiple items in this dialog – hold down Ctrl and click 
on multiple items, hold down Shift and click on the beginning and then on the end of a 
range of items or hold down your mouse button and drag it over a range of items.

Inserting Images through Drag and Drop



An alternate way to insert image blocks into a GIF file is to drag your source images 
from File Manager, Explorer or any other Drag and Drop-compliant file shell to the GIF 
Construction Set main window. Simply select the files you wish to insert and click and 
drag them to GIF Construction Set. The files will be treated as if you had selected them 
through Insert Image. An Image block will be created for each dropped file and inserted 
after the currently selected block in your GIF file.

By default, GIF Construction Set will add a Control block to your GIF file for each 
Image block it inserts through Drag and Drop. If you do not wish to have Control blocks 
added automatically, open the Setup dialog and switch off Add Controls for Drop.

You can only drop files into an open GIF file, or into an empty GIF file created by 
selecting New from the File menu. If you attempt to drop files into GIF Construction Set 
while it's displaying file and directory names, rather than the blocks of an open file, it 
will automatically create an empty GIF file to begin receiving image files.

GIF Construction Set will ignore files with extensions other than those it recognizes as 
graphic files.

Viewing GIF Files
The View button in the main window of GIF Construction Set for Windows will display a
GIF file using a fully compliant viewing function. The viewing area, as defined by the 
screen dimensions of the file header, will be centred in the main window of your screen if
it's bigger than your screen. Each displayable block will appear in the order it's defined in
the GIF file. You can terminate the display any time you like by clicking the right button 
of your mouse or hitting the Esc key.

The background of the view mode may appear dithered on systems with colour mapped 
screen drivers. This can be changed using the Setup dialog of  GIF Construction Set for 
Windows, as discussed elsewhere in this document.

If the screen dimensions defined by a GIF file's header block are greater than the 
dimensions of your screen, scroll bars will appear to allow you to pan over the displayed 
image.

Creating New GIF Files
To create a blank GIF file, select New from the File menu. A blank GIF file always 
includes a header block. You can add blocks to a new GIF file with the Insert and Merge 
functions.

Opening and Saving GIF Files
Any GIF 87a or 89a file can be opened into GIF Construction Set for Windows. Files 
created with GIF 87a headers will be converted internally to GIF 89a files. As discussed 



previously, you can open a GIF file either by selecting the Open item from the File menu 
of GIF Construction Set for Windows or by double clicking on the name of a GIF file in 
the main list of the application window. It's possible that extremely complex GIF files... 
those with lots of blocks... may not open completely. See the section of this document 
dealing with the Setup dialog for information about getting around this.

The Save and Save As functions of the File menu will save your current GIF file to disk. 
All GIF files written by GIF Construction Set for Windows will have GIF 89a headers. 

If you enable the Write Thumbnail option of the Save As dialog, each file written by GIF 
Construction Set for Windows will be accompanied by a thumbnail. Thumbnails are 
stored in files with the extension .THN. As such, the thumbnail for PICTURE.GIF would 
be called PICTURE.THN. The thumbnails created by GIF Construction Set for Windows 
are compatible with those used by Graphic Workshop for Windows and other Alchemy 
Mindworks applications which support thumbnails. 

Thumbnails will appear in the application window of GIF Construction Set for Windows 
if you select a GIF file prior to opening it. A thumbnail always represents the first image 
in a multiple-image GIF file.

Unregistered copies of GIF Construction Set for Windows will add a comment block to 
any GIF file you save. This comment block will not appear once you register GIF 
Construction Set for Windows.

Exporting GIF Files
The Export function will create a new, single-image GIF file which contains all the 
display elements of a multiple image GIF file. It will export what you would see on your 
screen if you were to click on View. Note that it will ignore image blocks which would be
removed to the background image.

The Courier New TrueType font that accompanies Windows must be installed for Export 
to render Plain Text blocks correctly.

Cutting, Copying and Pasting Blocks
You can cut or copy the current block of a GIF file to the Windows clipboard using the 
appropriate items of the Edit menu. A block copied to the Windows clipboard will have 
its block structure stored as hexadecimal data defined in OEM text. Plain text and 
comment blocks will have their text stored as conventional Windows text. Image blocks 
will have their image information stored as conventional Windows device-independent 
bitmaps.

It's a really bad idea to mess with the OEM text objects copied from GIF Construction 
Set for Windows and then paste them back into GIF files.



You can copy a bitmap from another application onto the clipboard as a device-
independent bitmap and paste it into a GIF file through GIF Construction Set for 
Windows. It will be given an image block on the way in, which you can subsequently edit
if you like.

Closing GIF Files
If you select the Close item of the File menu of GIF Construction Set for Windows, the 
current GIF file will be closed and the list in the main application window will revert to 
showing you the names of all the GIF files in your current directory. Opening a new GIF 
file automatically closes the current one.

Converting Movies to GIF Files
GIF Construction Set for Windows will convert an AVI video clip file into an animated 
GIF file. There are two possible catches to using this feature – GIF files so created can 
get very large, and may take a while to create. The latter will be especially true if your 
source AVI file has a lot of frames, or frames with relatively large pixel dimensions. Ten-
megabyte AVI files aren't uncommon – ten megabyte GIF files are not well regarded as 
adjuncts to web pages.

To convert an AVI file to GIF, select Convert Movie to GIF from the File menu of GIF 
Construction Set for Windows. Select a source AVI file. A dialog will appear to let you 
choose a colour management strategy for your GIF file. Here are the choices and what 
they mean:

Dither to the Netscape 216-colour palette: This will preserve the photographic quality 
of a photorealistic movie if it's viewed on a machine running Netscape and a 256-colour 
driver. This is technically the safest choice for movies which will be displayed in web 
pages – it will introduce some dithering into your movies, but it will avoid radical colour 
shifts even on cheap computers from Sears.

Remap to the Netscape 216-colour palette: This is technically the best choice for line 
art movies, such as those created by digital animation software, if you want them to look 
right in web pages which might be displayed by 256-colour machines.

Dither to the 256-colour orthogonal palette: This will do a slightly better job of 
dithering movies, especially 24-bit movies, than the Netscape 216-colour palette option. 
At least, it will if your movies will be displayed on a machine with a 32,768-colour or 
better screen driver. Machines with 256-colour drivers will cause Netscape to introduce 
some colour shifts into movies with this palette. 

Remap to the 256-colour orthogonal palette: This uses a slightly larger palette for line-
art movies. It will give you slightly better results for movies shown on a machine with a 
32,768-colour screen driver or better, and slightly worse results for 256-colour machines.



Use source image palette: This option makes no attempt to adjust the source palette of 
the movie being converted, and it doesn't dither anything. This will unquestionably 
produce the best-looking results for movies to be displayed by GIF Construction Set's 
View mode and by Netscape for machines with 32,768-colour screen drivers or better. 
Machines with 256-colour drivers will probably introduce some colour shifts into movies 
converted with this option. Life's a bitch this way. This option is also vastly quicker than 
the previous four, as it doesn't have to process each frame of the source image. You can't 
use this option with 24-bit source movies.

All of the foregoing notwithstanding, you should probably use the source image palette 
option unless you have a good reason for doing otherwise. The resolution of most movie 
files at the moment isn't all that impressive as it is, and introducing dithering into them 
will noticeably degrade them. Plan to experiment with this a bit.

Note: Converting movie files to GIF files can create a lot of blocks. Plan on two 
blocks per frame, plus at least a header and possibly a loop block. If you encounter 
memory or block access errors during conversion, increase the Maximum Blocks 
value in Setup and try it again. A good start for Maximum Blocks is 1024.

Converting GIF files to Movies
You can convert animated GIF files to AVI files through the GIF to Movie option of the 
File menu of GIF Construction Set. For the most part, this will be a fairly transparent 
process -- there are a few things to keep in mind, however.

- You cannot convert GIF files having local palettes for some or all of their images to AVI
files.

- Each frame in an AVI file must appear for the same length of time. GIF Construction 
Set will set the frame delay time for AVI files at the longest delay time of all the frames in
your source GIF file.

- Plain Text blocks are ignored by the GIF to AVI converter.

- You must have at least two Image blocks in your source GIF file to convert to AVI.

- AVI files are lossy -- they sacrifice some detail for better file compression. You can 
adjust the amount of detail loss in an AVI file being written by GIF Construction Set by 
editing the \WINDOWS\GIFCON.INI file and changing this item:

AVIQualityFactor = 6500

The quality factor can range from 10 to 10000, where 10000 will give you almost perfect 
reproduction and truly enormous AVI files. Make sure GIF Construction Set is not 
running when you edit its INI file.



- If you convert a very small GIF file to AVI, it may not play properly in some 
applications as its window will be stretched to allow for a title bar, minimize and 
maximize buttons and so on. There's nothing actually wrong with the file -- this is just 
how some AVI players handle tiny files.

- Loop blocks are ignored by AVI files -- you can't specify looping in an AVI movie.

- Dithered images converted to AVI files will typically lose some quality -- set the 
AVIQualityFactor set to a high value to minimize this.

- Converting GIF files to AVI movies will almost always result in AVI files which are 
several times the size of the source GIF files from whence they have come.

Previewing Movies
The Preview Movie function will let you see what an AVI movie looks like before you 
convert it to GIF.

Supercompressor
The Supercompression option of the GIF Construction Set File menu will squeeze a bit 
more compression out of the GIF file format. It applies several technques to GIF images 
to allow you to store them in less disk space, and hence to download them in less time.

Note that in some cases the supercompressor will actually modify the images in your 
files. They will display as if nothing has happened to them, but they may prove difficult 
to edit or use in other applications. It's a very good idea to save your supercompressed 
images to a new file name, and keep your original files as they were.

Supercompression applies the following techniques to your files. Not all these options 
will be available all the time -- in files which will not benefit by using them, they will be 
disabled.

Palette Compression: This function analyses all the images in a GIF file and figures out 
how many palette colours are being used by them. Unused colours can be discarded from 
the global palette. If enough unused colours turn up, the image can be compressed with 
fewer bits per pixel, saving some space. Note that this feature often manages to reduce 
the colour depth of images without making their file sizes all that much smaller. Unused 
bits in GIF pixels compress very effectively, and as such don't contribute all that much to 
file sizes when they're present.

Prune Compression: This function, also called "dirty rectangle" compression, will prune
away the exterior of an image if the area below it has the same pixels. It only works on 
GIF files having multiple images, and then only if the images have identical edges. 
Having pruned an image, it will relocate the new image to place it correctly over the 
underlying image, with the result that nothing will appear to have changed when the GIF 



file is displayed. This feature will not be available if your GIF file includes one or more 
Control blocks with transparency enabled or with their Remove By fields set to 
Background or Previous Image.

Comment Block Deletion: This function removes all the Comment blocks in a GIF file. 
Please don't use this feature indiscriminately, such as to remove the copyright notice of 
someone else's GIF file. Note that Comment blocks added automatically by GIF 
Construction Set, such as identity and unregistered shareware blocks, will be deleted by 
this dunction but they will reappear when you save your file.

Plain Text Block Deletion: This function removes all the Plain Text blocks and their 
associated Control blocks from a GIF file. At present, most web browsers do not support 
Plain Text blocks, so these elements can be removed if they're found without changing 
the appearance of a displayed GIF file.

The supercompressor can often reduce your GIF files considerably -- but it won't turn a 
behemouth file into something reasonable. In some cases it won't do anything at all -- 
check its status display for an indication of how effective it has been.

Note that you must Save a supercompressed file once compression is complete.

Flip and Rotate
The Flip and Rotate function will allow you to rotate some or all of the blocks in a GIF 
file in 90-degree increments, and flip them horizontally and vertically. To use it, select 
Flip and Rotate from the Block menu. In the dialog that appears, select the blocks you 
wish to modify, or click on Select All to modify all the image blocks in your GIF file. 
Select the function you wish to use and click on Apply. Click on OK to return to the main
GIF Construction Set window.

Crop
The Crop function will remove the area outside a selected rectangle for some or all of the 
images in a GIF file. Because the frames in animated GIF files tend to be fairly small, 
Crop will let you set the cropping rectangle dimensions numerically.

In using the Crop function, the Crop dialog will show you the first selected image. If the 
image is too large to fit in the available space, it will be scaled to fit. This only affects 
what you see -- your actual images will remain at their original size and resolution, minus
whatever you decide to crop off them.

Be careful in using the crop function -- it's fairly easy to crop the first of several frames 
correctly only to find that subequent frames used to have things that extended outside the 
crop area, but don't any longer.

Once an image has been cropped, the cropped-off areas are gone for good. It's a really 



good idea to Save As your cropped GIF files to a new name.

Cropping supports all the section features of the Manage function, discussed elsewhere in
this document.

Scale
The Scale function will allow you to change the size of one or more images in a GIF file. 
You can scale images by size or factor -- that is, you can scale them to specific pixel 
dimensions or you can scale them by a percentage. Note that scaling to a factor of 100 
percent has no effect. Scaling to a factor of 50 percent will result in a graphic which is 
half the size of the original. Scaling to a factor of 200 percent will result in a graphic 
which is twice the size of the original. 

In scaling down, the Scale function throws away some of the pixels in your source image.
In scaling up, it duplicates some of the pixels. As such, scaling always introduces some 
image degradation into your graphics. Use it carefully.

Once an image has been scaled, the changes made to it are permanent. It's a really good 
idea to Save As your scaled GIF files to a new name.

Scaling supports all the section features of the Manage function, discussed elsewhere in 
this document.

Colour and Balance
The Colour and Balance function in the Block menu will allow you to fine tune the 
colour, brightness and contrast of your GIF files. It applies to all the colours in all the 
images in a file, making it quick and easy to make global changes to the overall colour of 
an animated graphic. The View button can be used to preview what you've done. The 
Reset button will return all the controls to their default positions. In this position, the 
Colour and Balance fuction will have no visible effect on your graphics.

Scripting
Note: the Scripting feature of GIF Construction Set is quite technical and is in no 
way part of the primary function of the software. Unless you specifically need to 
have another program create GIF files automatically by calling GIF Construction 
Set, you are strongly advised to be nice to your mind and skip this section.

The scripting feature of GIF Construction Set allows another application to use GIF 
Construction Set as a GIF-building engine. In its script mode, GIF Construction Set will 
not display anything unless you ask it to. It reads a list of instructions from a text file, its 
"script", and builds a GIF file accordingly. When it's done, it terminates.

Unregistered users of GIF Construction Set will see the GIF Construction Set shareware 



beg notice when the script mode terminates. No notice will appear for registered users.

To run GIF Construction Set in script mode, you must pass it a path to your script file and
append /S to the file name. For example, here's how you would run GIF Construction Set 
and have it execute the script called MYSCRIPT.SCR in the directory \TEXT.

C:\GIFConstructionSet\GIFCON32.EXE C:\TEXT\MYSCRIPT.SCR/S

A script file consists of commands for GIF Construction Set, with one command per line. 
Most commands generate GIF blocks. Commands usually have arguments which set 
parameters in the GIF blocks being created. An argument consists of the argument name, 
an equal sign and the argument data. For example, this argument defines a file path:

PATH=C:\PICTURES\VENUS.GIF

Here are the legal commands for a script file and their arguments. The commands and 
arguments shown in bold are mandatory -- if they're not present, your script will not 
execute. If you omit the optional arguments, default values will be used. If a script fails to
execute, no GIF file will be created and GIF Construction Set will return a non-zero error
code.

Script arguments which include spaces must be surrounded by quotation marks, like this:

TEXT="This is a comment block"

Comment lines can be added to a script by preceding them with a semicolon. These lines 
will be ignored by GIF Construction Set.

STATUS
The STATUS command does not create a block in your GIF file. It's used to help 
you work out the problems in scripts that don't seem to be behaving themselves. It
can be added to a script to create a log of what's happening when your script 
exectutes. It recognizes the following arguments:
PATH

The PATH argument should define a path to a text file which GIF 
Construction Set will create and write its log to. The log will include each of 
the script lines processed until the script is complete or until an error occurs. 
In the latter case, an error message will be the last entry in the log.

SHOWERROR
The SHOWERROR argument can be either TRUE or FALSE. If it's TRUE, a 
message window will appear when GIF Construction Set finishes processing a
script or encounters an error.

FILENAME
The FILENAME command defines the file name and path for the file to be 
created by the script. It recognizes the following argument:



PATH
The PATH argument defines the destination file name.

HEADER
The HEADER command creates a Header block. The must be one HEADER 
command in every script file, and it must precede all other commands with the 
exception of STATUS and FILENAME. It recognizes the following arguments:
PATH

The PATH argument defines a file from which the global palette of the GIF 
file should be extracted. This can be either a GIF Construction Set CMP 
colour map file or an image file in any supported format. If PATH specifies a 
24-bit image, the 256-colour orthogonal palette will be used. The PATH 
argument should not be used if the PALETTE argument is present. If neither 
PATH nor PALETTE are used, the default palette type as set in GIF 
Construction Set's Setup dialog will be used.

BACKGROUND
The BACKGROUND argument defines the colour index number of the 
background colour for the file. Its argument can be a number between zero 
and 255. Make sure that you don't specify a background value larger than the 
size of the global palette.

PALETTE
The PALETTE argument will select one of GIF Construction Set's default 
palette types. Its value must be one of the following:

PALETTE2 -- Two colours
PALETTE16 -- Sixteen-colour Windows reserved

PALETTE32 -- 32-colour orthogonal
PALETTE64 -- 64-colour orthogonal
PALETTE128 -- 128-colour orthogonal
PALETTE216 -- 216-colour Netscape
PALETTE256 -- 256-colour orthogonal
PALETTE256G -- 256-colour orthogonal with 32 greys
PALETTE256GREY -- 256-level grey scale
LOCAL -- No palette

The PALETTE argument should not be used if the PATH argument is present. 
If neither PATH nor PALETTE are used, the default palette type as set in GIF 
Construction Set's Setup dialog will be used.

IMAGE
The IMAGE command adds an Image block to your GIF file. It recognizes the 
following arguments:
PATH

The PATH argument defines a path to the source file for the Image block 
being created. The source image can be in any of the graphic file formats 
supported by GIF Construction Set.

MODE



The MODE argument tells GIF Construction Set how to manage the palette of
this image if it doesn't match the global palette. The values for the MODE 
argument can be:

DITHER -- Dither to the global palette
REMAP -- Remap to the global palette
LOCAL -- Use a local palette

LEFT
The LEFT argument defines the left position of the image. This value can be 
any positive number.

TOP
The TOP argument defines the left position of the image. This value can be 
any positive number.

COMMENT
The COMMENT command adds a comment block to your GIF files. It recognizes the
following arguments:

TEXT
The TEXT argument defines the literal text to be used in the Comment block 
being created. It should be fairly short -- command lines in Script mode are 
limited to 256 characters. The TEXT argument should not be used if the PATH
command is present.

PATH
The PATH argument specifies a path to a plain ASCII text file from which text
for a larger Comment block can be read. Formatted word processing 
documents and other sorts of files are not suitable. Up to 32767 characters can
be included in a comment block, although few users of your GIF files will 
thank you if you include anything like this much text in them. The PATH 
argument should not be used if the TEXT command is present.

LOOP
The LOOP command adds a LOOP block. For proper operation, this command 
must appear immediately after the HEADER command. It recognizes the 
following argument:
ITERATIONS

The ITERATIONS argument defines the number of times your GIF file will 
loop. It must have a value between zero and 32767.

CONTROL
The CONTROL command adds a Control block to your GIF file. A GIF file 
should have one Control block before each Image block. The CONTROL 
command recognizes the following arguments:
DELAY

The DELAY argument specifies the number of 1/100ths of a second for the 
following image to be visible before it's removed. This number can range 
between zero and 32767.

TRANSPARENT



The TRANSPARENT argument specifies a transparent colour index. It must 
range between zero and 255. Make sure you don't specify a colour beyond the 
range of your image palette.

WAITFORINPUT
The WAITFORINPUT argument can be either TRUE or FALSE. It defines 
whether the Wait for User Input flag will be enabled in this Control block. 
Note that at present Netscape ignores this flag.

REMOVEBY
The REMOVEBY argument defines the method by which your image will be 
removed from the screen when the delay period has expired. It can be one of 
the following values:

NOTHING -- The image is left unremoved
ASIS -- The image is left unremoved
PREVIOUS -- The image is replaced by the 

previous image 
BACKGROUND -- The image is replaced by the 

background
Note that under Netscape, only NOTHING and BACKGROUND are 
recognized.

Here's an example script file:

;
; EXAMPLE SCRIPT
;
STATUS PATH="c:\test.txt" SHOWERROR=TRUE
LOOP ITERATIONS=10000
FILENAME PATH="c:\test.gif"
HEADER BITS=8 PATH="C:\GIF\APR89.GIF"
CONTROL INTERLACE=TRUE
IMAGE PATH="C:\GIF\APR89.GIF" MODE=DITHER
COMMENT TEXT="This is an example comment block."
COMMENT PATH="c:\text\textfile.txt"
CONTROL DELAY=1000 REMOVEBY=PREVIOUS
IMAGE PATH="C:\GIF\WINGS.GIF" MODE=DITHER INTERLACE=TRUE
;
;END OF SCRIPT
;

Keep in mind that the script mode has fairly limited sanity checking -- if you fill its brain 
with monkey dandruff, you'll probably find monkey dandruff in your GIF file.

The Setup Dialog
The GIF Construction Set for Windows Setup dialog can be called up through the Setup 



item of the File menu. It includes the following fields.

- Display Interlaced: If this switch is enabled, image blocks with interlaced images will 
appear in interlaced order.

- Draw Frame Guides: It this switch is enabled, purple guides will appear to define the 
image area of a GIF file being viewed using the View buttons of the edit dialogs. Guides 
do not appear in the main View function.

- Use Image Offsets: If this item is not enabled, images will be displayed centred on 
your screen, rather than where the position fields of their image blocks say they're 
supposed to be. There are few good reasons for doing this.

- Dither View Background: This item is ignored on systems with screen drivers that can 
display more than 256 colours. If your current Windows screen driver can display 256 or 
fewer colours, setting this switch on will cause the background of the main View mode to
be dithered to approximate the setting of the background field of the header block of the 
GIF file being displayed. Setting it off will cause the closest match from the current 
global palette to be used, allowing for Window's somewhat funky palette management 
strategy. See the section of this document which deals with the About dialog of GIF 
Construction Set for Windows for information about how to determine the number of 
colours your current Windows screen driver can display.

- True Transparency: If this item is enabled and you're using a Windows screen driver 
with better than 256 colours, you'll see transparent GIF files displayed correctly. If it's 
disabled – or if you have a sixteen- or 256-colour Windows screen driver installed in your
system – GIF Constrcution Set will use Windows' GDI calls to handle transparency, 
which are less than wholly reliable. They are somewhat faster, however. If you find the 
length of time it takes GIF Construction Set to display transparent elements in GIF files 
excessive, try disabling this feature. This switch will be ignored if you have a sixteen- or 
256-colour driver installed.

- Write Directory Block: If this item is enabled, GIF Construction Set will preserve the 
titles of the image blocks in your GIF file in a Block Title block written after all the other 
blocks in the file. This is helpful in keeping track of the images in an animation sequence,
for example. This item should be disabled if you are creating GIF files for use on web 
pages.

- Interlace Delay: This is the number of milliseconds GIF Construction Set waits after it 
display one line of an interlaced image.

- Dither Contrast and Dither Brightness: These values only affect monochrome 
dithering in the image block import function. If you attempt to import a colour image into
a monochrome GIF file, it may be dithered to two colours, depending on the palette 
option you select. These fields can be used to fine tune the dithering.



- Default Palette: This item sets the initial palette size for the header of blank GIF files 
created with the New function of the File menu. There are a number of palette options:

- 256 colours: This palette has an even dispersal of colours between black and white.
- 256 colours with grey: This palette has an even dispersal of colours between black and 
white, but it includes 32 levels of grey.
- 216 colours/Netscape: This is the palette Netscape uses to remap colour images to for a 
256-colour machine. This should be the default palette setting for creating photorealistic 
GIF files for use with Netscape.
- 32, 64 and 128 colours: These are evenly dispersed palettes. The 32-colour palette is a 
bit dificient in blues.
- 16 colours: This is the sixteen-colour Windows palette.
- 2 colours: This palette includes all the colours of the rainbow, provided they're black 
and white.

- Adjust Header on Save: If this item is enabled, GIF Construction Set will calculate the
correct Screen Width and Screen Depth values for every GIF file it saves to disk. It's a 
really good idea to let it do this.

- Check Animations: If this item is enabled, GIF Construction Set will analyze GIF files 
which have more than one image as it saves them to disk and warn you if they contain 
elements that might cause problems under Netscape. You can ignore these warnings for 
non-animated GIF files. The EXAMPLE.GIF file that comes with GIF Construction Set 
will set off lots of warnings if you attempt to save it to disk – this is nothing to be 
concerned about, as it's not an animated GIF file.

- File Identification: If this option is enabled, GIF Construction Set will add a comment 
block to each GIF file it writes. The comment block will identify of the owner of the copy
GIF Construction Set that wrote the file. If you're a registered user of the software, this 
will be your registration name and the company you work for, as entered when you 
installed Windows. If you're using an unregistered copy of GIF Construction Set, this will
be your name and company as entered when you installed Windows, or a message stating 
that this information could not be found. Alternately, you can supply your own text for 
this block. To do this:

1. Make sure GIF Construction Set is not running.
2. Use the Notepad application to edit \WINDOWS\GIFCON.INI
3. Locate the entry IdentificationFile and add a path to the text file to use.
4. Save the file.

The text file pointed to by IdentificationFile must be pure ASCII text, not a word 
processor document. It can contain up to 16000 characters, although few users of your 
GIF files will thank you for including anything like this much comment text in them. 
Tabs will be replaced by single spaces.

GIF Construction Set will only add one identification block to a GIF file -- if it finds one 



in the file it's editing, it will not add a second one. This assumes that the text of the one it 
finds matches the text it would otherwise have written, of course.

You can use this feature to automatically add a copyright message to files that you create 
with GIF Construction Set -- make sure that this message does not accidentally get added 
to files which you did not create, but merely opened and meddled with a bit.

If this item is disabled, no identification comment block will be added to your files.

- Add Controls for Drop: If this item is enabled, a Control block will be added 
automatically for each mage block created when image files are dragged to GIF 
Construction Set.

- Uncompressed GIF: This option will cause images written by GIF Construction Set to 
be stored uncompressed. Such files are legal GIF files, and can be read by other GIF 
readers. However, they embody no LZW compression -- they can also be read by LZW-
free GIF readers. Note that uncompressed GIF files will typically be larger than their raw 
image data by a considerable margin.

- Detailed Main List: If this item is on, the main block list will display additional 
information about each block. If it's off, only the block names themselves will be 
displayed.

- Paint Program: The Image block editor in the 32-bit build of GIF Construction Set can
call an external paint package to edit images. By default this will be Windows Paintbrush.
The controls in this group do the following:

Maximize: Turn this on to cause the paint application to be maximized when it's 
called. Turn it off to allow it to open normally.

Use Windows Paintbrush: This switch will cause GIF Construction Set to disable 
the Paint function in cases where using Windows Paintbrush might mangle your 
image, such as attempting to edit a 256-colour image on a system with a sixteen-
colour screen driver. If you turn this switch off, you'll be free to edit your images even
if it's less than wholly advisible to do so if you are in fact using Windows Paintbrush 
-- you have been warned.

Browse: This button will let you select the executable file for the paint application to 
be called by GIF Construction Set. The path to the Windows Paintbrush application 
will be set by the GIF Construction Set installer, and you should not have to mess 
with this unless you move things around on your hard drive or if you want to use a 
paint application other than Windows Paintbrush. It's worth noting that while 
Windows Paintbrush periodically establishes new horizons in funkiness -- 'specialy 
the sixteen-bit version -- it's arguably better suited to creating small GIF graphics than
are its smarter descendants. Most large image editing suites, aside from being dead 
slow to load, do more anti-aliasing and other high-end image processing than you will



probably find desirable.

- Registration Name: You can turn a shareware copy of GIF Construction Set for 
Windows into a registered copy by entering your name in the registration field and 
clicking on Accept. A dialog will appear prompting you for the key word provided with 
the receipt for your registered copy of  GIF Construction Set. Enter this word and click 
on OK. 

Once you have successfully registered GIF Construction Set for Windows, you will no 
longer see the beg notice when the application terminates and the extra comment block 
added when you save a file will not appear. In addition, you'll have great karma and our 
leather-winged demon of the night won't regard you as a handy source of protein... 
something well worth considering.

The About Dialog and Windows Screen Drivers
The About button in the button bar of GIF Construction Set for Windows will display a 
beg notice for unregistered versions and a grey dialog with a unicorn for registered 
versions. The latter dialog will also tell you several useful things about your computer, 
such as the amount of memory Windows thinks is free and the number of colours your 
current Windows screen driver can display without dithering. The latter is very 
important... if you attempt to view a 256-colour GIF file on a system with a sixteen-
colour driver installed, the resulting images will look posterized and ugly. This does not 
mean that GIF Construction Set for Windows is misbehaving... you must update your 
Windows screen driver to see 256-colour images correctly. 

If you have an unregistered copy of GIF Construction Set for Windows, you can see the 
latter dialog by holding down the shift key and clicking on the Ok button in the beg 
notice dialog. You should do this if you are not seeing 256-colour images displayed 
correctly to check if the problem is with your screen driver.

As an aside, this works the other way, too... should you have reason to wish to see the 
unregistered beg notice dialog after you've registered, hold down the shift key and click 
on the Ok button.

About the Block Name Blocks
At times it's convenient to know which files the source images in a multiple image GIF 
file have come from, or to otherwise add titles to the Image blocks in a GIF file. The GIF 
specification doesn't allow for this to be done per se, but GIF Construction Set provides 
this facility through its Block Name blocks. If the Write Block Titles option in Setup is 
enabled, GIF Construction Set will add an extra Application block to GIF files it writes 
with title information for the Image blocks in the files in question.

By default, the title for an image will be the name of the file the image was read from 
when you imported the image into GIF Construction Set with the Insert function. You can



change this by editing the title in the Edit Image dialog.

If you turn off the Write Block Title option, delete the Block Name block from a GIF file 
and then save the file, the Name Block will go away. This will delete the names and free 
up whatever space they occupy. It's probably a good idea to do this if your GIF files are 
bound for a web page.

The Block Name blocks associate text with blocks based on the block position in your 
GIF files. If you use another application to add or delete blocks to a GIF file, the block 
information probably won't appear, or won't appear correctly.

Creating Banners
Banners are GIF files which contain text. This can be simple text – that is, a single image 
GIF file with words painted on it – or it can be an animated GIF file with text which 
scrolls from right to left.

Banner text can be painted with one of several effects:

Simple: the text is painted in the Foreground colour against the Background colour.

Shadow: The text is painted in the Foreground colour against the Background colour 
with a shadow in the Shadow colour.

Embossed: The text is painted as an embossed object in the Foreground colour 
against the Background colour. 

Backlight: The text is painted in black against a black background. A glow appears 
around the outline of the text. The glow colour is set by the Backlight button.

Neon: The text is outlined in the Foreground colour and a glow in the Backlight 
colour appears around it. For the most attractive results, the Foreground colour should
be black, white or something close to the Backlight colour -- other combinations may 
look ugly enough to mutate bacteria.

Soft Shadow: The text is drawn in the Foregound colour with a grey soft shadow. 
The density of the shadow can be set with the Grey Level button. The displacement 
between the text and its shadow is set by the Offset button. Note that this function 
does some internal cheating with the palettes of the images it creates -- its images 
may look a bit dithered if you display them on a 256-colour machine. If the Extra Soft
item is enabled, the shadow will appear more diffused -- this effect becomes 
increasingly noticeable as the shadow density becomes darker. Soft Shadow text is 
always drawn against a white background.

Teletype and Teletype with Shadows: The text is painted in the Foreground colour 
against the Background colour optionally with a shadow in the Shadow colour. The 



text appears one character ata time. The cell count of the final GIF file will be 
determined by the number of characters in the text.

Texture and Texture with Shadows: The text is painted in the currently selected 
texture against the Background colour, optionally with a shadow in the Shadow 
colour. It can be outlined in the currently selected Foregound colour. See the 
discussion of textures, below. 

Banners almost always use the current default palette, as set in the GIF Construction Set 
Setup dialog. The exception is the Soft Shadow effect, which uses a grey-scale palette. 
Changing the default palette resets the colours in the Banner dialog. Also, note that only 
the Simple text option is available if the two-colour default palette is selected.

The Rolling option determines whether a banner will be a single static image or a 
sequence of images in which the text appears to move from right to left. Note that rolling 
banners with large fonts can create very large GIF files.

The Cells option determines the number of frames in a rolling GIF banner.

The Delay option sets the number of 100ths of a second between cells for a rolling 
banner.

The Loop option determines whether a rolling banner will repeat indefinitely or only 
display once.

The Offset control sets the offset in pixels between text and its drop shadow or the size of
embossed text. Banners with a drop shaodw of one or two pixels and a a drop shadow 
colour of black or another very dark colour look pretty cool.

The Font button selects the font to be used in creating a banner.

The Transparent Background option sets the background colour to be transparent for the 
banner you're creating. This effect won't really be visible in the Test mode, as the default 
background of your GIF file will be the same as the background colour – banners with 
transparent background will appear as such in web pages.

The Foreground, Background and Shadow colour buttons set the colour values to be used
in creating banners.

The Test button will let you preview your banner.

The Sample Text window will show you the font size and colours for your banner – drop 
shadow and emboss effects will not appear in this window.

If the palette compression option is enabled, your GIF file will be stored with the least 
possible colour depth.



The Texture feature of the Banners function allows you to define patterns to be used to 
fill your text with. Any small image fragment can be used as a texture -- the sorts of 
images that make good web page backgrounds also make good textures for this purpose. 
Ideally, texture patterns should repeat seamlessly.

A small library of texture patterns is installed with GIF Construction Set. You can select 
the current texture for filling text banners by clicking on the Texture button. The Texture 
dialog will also allow you to configure the texture feature's characterists, as follows:

Outline: If this option is enabled, your text drawn with the Texture effect will have a 
one-pixel outline in the current foreground colour.

Dither: If this option is enabled, textures will be dithered to the palette of the GIF file
being assembled. If it's disabled, they'll be remapped. Dithering will produce better 
colour matching with poorer detail resolution, while remapping will produce better 
detail resolution but somewhat posterized colours in some cases. Dithering is the 
better choice for complex, organic textures and remapping is usually better for simple
mechanical textures.

Walking Texture: If this item is enabled, textures will move with the text they fill in 
rolling banners. This will produce the illusion of text cut out of a textured material 
moving across your screen. If this item is disabled, the textures will remain 
motionless. This will produce the illusion of your text being cut out of a sheet of solid
material which is being moved over a textured surface.

The Add button in the Texture dialog  will allow you to add textures to the GIF 
Construction Set texture library. Textures can be drawn from image files in any of the 
formats GIF Construction Set supports for importing, including GIF, JPEG, BMP, Targa 
and so on. You will achieve much more attractive results with textures if you start with 
24-bit source images, such as from JPEG files.

Textures are stored in the parent directory of GIF Construction Set with the extension 
TTR. TTR files are actually Windows BMP files with a different file extension -- should 
you wish to create lots of TTR files quickly, use Graphic Workshop to convert to BMP 
and then just rename all the files accordingly.

Having said this, keep the size of your texture library modest, lest the Banner dialog take 
a very long time to open.

The Delete button in the Texture dialog will delete the currently selected texture. That 
this deletes its parent TTR file -- once thus deleted, it's gone for good.

Note that the texture swatches in the Texture dialog and on the face of the Texture button 
in the Banner dialog may be dithered if your current Windows screen driver cannot 
display enough colours to handle them. This does not affect how they'll appear in your 



final GIF files.

Creating Transitions
Transitions are single image GIF files which have been augmented with special-effect 
transitions to make them appear and disappear in interesting ways. To create a transition, 
begin by selecting the source image with the Select button. Note that Transition doesn't 
modify your source image – it creates a new copy of it.

Transitions with large source images can create unworkably large final GIF files. Be 
careful how you use this feature if you're creating images for web pages.

Here are the current special effects supported by the Transitions feature:

Adam Seven Interlace: This will display your image one pixel at a time, in complex 
interlace order. This effect simulates the interlacing used by PNG files.

Horizontal Split: Your image will appear in two sections, with half rolling in from 
the left of your frame and half rolling in from the right.

Sandstorm: Your image will appear one pixel at a time, in random order.

Tile: Your image will appear in small squares, in random order.

Vertical Split: Your image will appear in two sections, with half rolling in from the 
bottom of your frame and half rolling in from the top.

Wipe in From Bottom: Your image will roll in from the bottom of your frame.

Wipe in From Left: Your image will roll in from the left side of your frame.

Wipe in From Right: Your image will roll in from the right side of your frame.

Wipe in From Top: Your image will roll in from the top of your frame.

The Select button will allow you to choose the source image for your transition. Source 
images can be in any of the file formats GIF Construction Set supports for import, as 
discussed elsewhere in this document.

The Cells option determines the number of frames in a transition.

The Delay option sets the number of 100ths of a second between cells for a transition.

The Loop option determines whether the transition will repeat indefinitely or only display
once.



The Transparent Background option sets the background colour to be transparent for the 
transition you're creating. This effect won't really be visible in the Test mode, as the 
default background of your GIF file will be the same as the background colour – 
transitions with transparent background will appear as such in web pages.

The Remap to Default Palette option will cause your source image to be adjusted to use 
the currently selected default palette, as configured in the Setup dialog. This may result in
noticeable dithering artifacts if your source image has already been dithered once, but it 
improves Netscape's colour reproduction for 256-colour systems.

The Background colour button sets the background to be used in creating transitions.

The Test button will let you preview your banner.

The Pause After Cycle option causes a transition to pause when it has completed its 
image, and before it begins to remove it. The pause also occurs after an image has been 
completely removed if the Loop option is enabled. The duration of the pause is set by the 
Pause spin button.

The Appear and Disappear options determine whether your transition will include an 
appearing sequence, a disappearing sequence or both. One or both options must be 
enabled.

If the palette compression option is enabled, your GIF file will be stored with the least 
possible colour depth.

Note that you can modify transitions once they've been created and opened in GIF 
Construction Set, just as you would other animated GIF files. For example, you can 
combine different transitions by merging a file with just the Appear phase enabled with 
one having just the Disappear phase enabled.

Creating LED Signs
The LED Sign function of GIF Construction Set for Windows will allow you to create 
scrolling banners which resemble the LED signs found in subways, video stores, airports 
and many up-market churches. You can program GIF Construction Set's signs for colour 
changes, adjustable playback speed and varying sign dimensions.

The text for an LED sign is displayed in white LEDs by default. Technical sorts will 
observe that there's no such thing as white LEDs -- we would note that this is only true in 
the real world, with which LED signs have as little contact as possible. You can change 
the display colour at any point in the text by embedding a colour code. Colour codes 
consist of the @ sign followed by a letter. Here are the legal colour codes:

@R -- red
@G -- green
@B -- blue



@C -- cyan
@M -- magenta
@Y -- yellow
@W -- white

Here's some example coded text:

This text is @Rred, @Ggreen, @Bblue, @Ccyan, @Mmagenta, @Yyellow, @Wand white.

This is what the colours would appear as in the LED sign function:

You can include as many colour changes as you like in a sign, as long as the total text 
length including the colour codes is no greater than 260 characters.

LED signs can generate a large number of individual images, and hence potentially large 
GIF files. Mitigating this to some extent is the nature of the individual images in a sign. 
They're sixteen-colour graphics, and use simple, predictable shapes that compress well. 
As such, it's possible to create fairly complex signs without necessarily making them 
unworkably long to download. Note the observations about file size below.

Here's what the controls in the LED Sign function do:

Loop: If this item is enabled, the sign will continually repeat itself. If it is not 
enabled, this sign will cycle once and go dark.

Show Dark Pixels: If this item is enabled, LEDs that are not lit up will be displayed 
as dark grey. Note that this will typically increase the file size of a GIF file containing
an LED sign -- you will probably want to leave this one disabled.

Smooth Scroll and Columns per Frame: If the Smooth Scroll option is enabled, the 
sign text will scroll smoothly, moving by the number of pixels defined in the 
Columns per Frame control. This should be set to one for the smoothest scrolling. If 
Smooth Scroll is disabled, the sign text will scroll by the width of one character per 
frame. This is arguably less attractive, but it will typically create signs with far fewer 
images, and as such much smaller file sizes. If you do create signs with smooth 
scrolling enabled and you need to reduce the final file size, try increasing the 
Columns per Frame value slightly. This will result in somewhat less smooth scrolling,
but will reduce the number of images involved in displaying a complete sign quite a 
lot.

Compact Sign: If this item is enabled, GIF Construction Set will create small signs. 
If it's disabled, it will create large signs. Large signs look slick, but they result in 
much larger files.



Columns Wide: This field sets the number of vertical columns of LEDs in the sign to
be created. Large values will result in wider signs, capable of displaying more text at 
once, but also in larger final files.

Delay: This field sets the delay in 1/100ths of a second between images. Increase this 
value to slow down the scrolling of an LED sign. Note that if you adjust the Smooth 
Scroll or Columns per Frame items in the LED Sign dialog, you'll probably have to 
change this value as well.

Palette Compression: If this option is enabled, your GIF file will be stored with the 
least possible colour depth.

The text in a sign can consist of any printable ASCII characters between ASCII 32, a 
space, and ASCII 126, a tilde. Any other characters will be displayed as a double dagger 
symbol.

Creating Wide Palette GIF Files
Wide palette GIF files can only be created by the 32-bit version of GIF Construction Set.

The Wide Palette GIF File option will let you create GIF files which can display more 
than 256 colours. This probably sounds much more useful than it really is -- while it 
genuinely works, it embodies some serious catches. Before you use this feature, please 
take a moment to understand what it's up to so you don't wind up bashing your head 
against a wall in frustration.

A GIF image can only store a maximum of 256 colours. However, a GIF file can store 
any number of images. If each image has its own local palette, it's possible to have more 
than 256 different colours stored in the file.

This is what wide palette GIF files do. If the source image you wished to store in one had 
510 distinct colours, GIF Construction Set would create a GIF file with two Image 
blocks. The first Image block would have a local palette with the first 255 colours of your
source image in it. The second Image block would have a local palette with the second 
255 colours from your source image. Each palette would also have one colour that did not
appear anywhere in your source image, to be used as a transparent colour.

In discussing wide palette GIF files, the Image blocks that your source image will be split
into are called "panes".

The actual images would be constructed such that those pixels of your source image 
which appeared in their palettes would appear in the images in question, and the 
transparent colour would appear everywhere else.

When such a GIF file is displayed, the first Image block will take care of the first 255 
colours, and the second Image block will take care of the second 255 colours. Because 



the "unused" pixels are transparent, the two frames would essentially be merged when the
display was completely updated, with the result that 510 distinct colours would be 
displayed.

In practical terms, a 24-bit source image must be "quantized" to derive a suitable list of 
colours, that is, a large palette must be derived from it based on the dispersal of source 
colours. The Wide Palette GIF function of GIF Construction Set lets you select how large
this palette can get.

Wide palette GIF files allow you to enjoy lossless images having lots of colours in a 
format which is compatible with existing web browsers. However, they embody some 
important catches, as follows:

- Wide palette GIF files tend to get large, as they require that a single 24-bit image be 
split into multiple 256-colour images, each of which must be stored separately.

- While Netscape, Explorer 3.0 and GIF Construction Set will display wide palette GIF 
files correctly, almost nothing else will. This includes most GIF viewers and paint 
packages.

- If a wide palette GIF file is displayed on a system running with a 256-colour screen 
driver, it will look really awful.

- Wide palette GIF files cannot include transparency, as they use transparent colours for 
their own purposes. They could in theory be animated, if you wanted to push the 
envelope, but the results would be very, very slow and quite ugly.

- Netscape does occasionally refuse to display GIF files with local palettes if it's really 
starved for resources, and some of its betas have been known to crash under these 
conditions. Be warned.

Wide palette GIF files are created through the Wide Palette GIF option of the edit menu 
of GIF Construction Set. Here's what its options do:

Maximum number of colours: This sets the maximum possible wide palette size. If 
your image turns out to have fewer distinct colours than this, the palette may get smaller. 
As each pane in a wide palette GIF file can hold a maximum of 255 colours -- plus one 
transparent colour -- this also defines the maximum number of panes.

Interlace: If this option is enabled, the pane images of your wide palette GIF file will be 
written interlaced. This looks really slick in GIF Construction Set, but it will typically 
have no effect in Netscape, which does not display interlaced images as interlaced when 
they occur in multiple image GIF files.

Add Initial Sketch Image: If this option is enabled, the panes of your wide palette GIF 
file will be preceeded by a fairly coarse sixteen-colour version of the image, which will 



eventually be wholly overwritten by the following panes. It's something to look at in the 
mean time, however. Turn this feature off if you want to create slightly smaller GIF files. 
The sketch image ignores the Interlace option, and is always non-interlaced.

Fifteen-bit Quantize: This option will allow the wide palette GIF function to choose a 
better wide colour palette. It takes a lot longer to complete its work, however.

Wide Palette Dither: This option allows the wide palette GIF function to dither its 
images, minimizing the banding effects of colour remapping. Dithering with several 
thousand colours looks really sharp.

Select: Use this button to load a source image. Source images must be stored as 24-bit 
files -- that is, as true-colour BMP, JPG, TGA, PCX and PNG files, and other suitable 
formats. You cannot use a GIF file as the source for the Wide Palette GIF function.

Sorted Palette: If this option is enabled, the wide palette created by the Wide Palette GIF
function will be sorted, such that the brightest colours appear first, and turn up in the first 
panes. If it's not enabled, the palette colours will appear randomly. This won't affect how 
your wide palette GIF images look when they're finally displayed, but ti does affect what 
they look like as they're being built up on your screen. This is especially true if you 
enable the Interlaced switch. 

Test: This feature will test a wide palette GIF image. Considering the time it takes to 
create one of these things, you might want to skip the Test function.

Click on OK to create a wide palette GIF file. This feature takes a fairly long time to run 
-- it can be aborted by clicking anywhere within the GIF Construction Set window. When
it's complete, your wide palette GIF file will have been opened in the main list box of 
GIF Construction Set. Click on View to see what it looks like -- mind the earlier warning 
that it will look pretty ugly on a system with a 256-colour screen driver.

By default, the background colour of a wide palette GIF file will be white -- you can 
change this by editing its Header block. This doesn't matter to a web browser, which 
ignores the background colour values in GIF files.

Select the maximum colour size carefully. More colours will produce much better 
looking final images, but they'll also create much larger final GIF files.

Note: If you save a wide palette GIF file, open it into GIF Construction Set and then 
save it again -- for example, to add a comment block to it after the fact -- you will 
probably see some animated GIF warnings. Ignore these -- they're valid warnings, 
but wide palette GIF files are designed to break some of the rules for well-behaved 
web page animations. 

Creating Spin Effects



The Spin function in the Edit menu will rotate an existing image in two dimensions. It 
can be used to create multiple-image GIF animations which look like a spinning wheel or
other revolving object seen face-on.

Important: The Spin function only rotates in two dimensions. Think of a 
phonograph record, or if you're too young to have seen one outside a museum, think
of a CD-ROM viewed from above. This is distinct from rotation in three dimensions,
which requires a three-dimensional modelling package, ray tracing and several 
hours of rendering time. GIF Construction Set can do the former -- it cannot do the 
latter, nor is it likely to any time soon. If you contact us about how to do three-
dimensional rotation using the GIF Construction Set Spin function, we will with the 
greatest regret be forced to dispatch the oft-mentioned leather-winged demon of the 
night to do something unspeakably nasty to you.

Here's what the Spin dialog's controls do:

Select: Before you can use the Spin function, you must decide what you want to spin.
The Select button will allow you to select a source image file. Source images scan be 
drawn from any of the supported file types listed elsewhere in this document. Note 
that if you select a multiple-image GIF file as your source image, only the first image 
in the file will be used.

Direction: You can specify rotation that's clockwise or counterclockwise.

Steps: The Steps option determines the number of degrees each image in your final 
file will be rotated, and as such, the number of frames in your final GIF file. This can 
range from 2 to 360. More steps will result in smoother animation, but with larger 
final files and slower movement.

Delay: The Delay option sets the number of 100ths of a second between cells for a 
spin effect.

Loop: The Loop option determines whether the spin effect  will repeat indefinitely or 
only rotate once.

Transparent Background: The Transparent Background option sets the background 
colour to be transparent for the spin effect you're creating. This effect won't really be 
visible in the Test mode, as the default background of your GIF file will be the same 
as the background colour – spin effects with transparent background will appear as 
such in web pages.

Remap to Default Palette: The Remap to Default Palette option will cause your 
source image to be adjusted to use the currently selected default palette, as configured
in the Setup dialog. This may result in noticeable dithering artifacts if your source 
image has already been dithered once, but it improves Netscape's colour reproduction 
for 256-colour systems.



Background: The Background colour button sets the background to be used in 
creating spin effects.

Test: The Test button will let you preview your graphic.

Destination Rectangle: These controls determine the size of the area in which your 
graphic will rotate. The Maximum option will create a final GIF file which is big 
enough to include all the rotated parts of your source image. The Minimum oftion 
will create a final GIF file which only encompasses the area that's common to all the 
rotated frames. The Original option will create a final GIF file which has the same 
dimensions as your source image. 

Palette Compression: If the palette compression option is enabled, your GIF file will
be stored with the least possible colour depth.

Note that rotating a bitmap will usually impose some rotation artefacts on it -- you might 
find that your image is slightly degraded at some rotation angles. This will be a lot more 
apparent if you use dithered source images.

Creating Image Strips
You can export a multiple-image GIF file to a single image GIF file image strip through 
the Image Strip item in the Block menu. This will result in each of the images of your 
source GIF file being arranged one after the other in a long, narrow GIF file, much like 
the imges on a strip of movie film. 

When the size of an image strip is calculated, GIF Construction Set will allow a space 
equal to the largest frame in the source file for each image. In a file with images of 
varying sizes, smaller images in the resultant image strip will be centered in a frame of 
the current background colour of the file, as derived from the current background colour 
of the source GIF file.

This feature is useful for creating Java applets which display images. You will require the
Sun Microsystems Java development kit to compile Java applet source code.

Here's what the options do:

Horizontal strip: Creates an image strip in which the images are laid out horizontally.

Vertical strip: Creates an image strip in which the images are laid out vertically.

Tranparent background: This will make the background colour of the image strip 
transparent. Use this feature carefully, as it might make some pixels in your images 
transparent too, if they happen to be the same as the background colour.



Descriptive comment: This feature will add a comment block to your image strip GIF 
file which specifies the number of cells in the file and the dimensions of each cell.

Creating Animated GIF Files
GIF Construction Set for Windows offers two approaches to creating animated GIF files. 
You can use the Animation Wizard feature of the File menu, or you can create animated 
GIF files by hand. The former is much easier and will not create animated GIF files 
which are wildly inappropriate for use with Netscape and other web browsers. The latter 
will avail you of much more control over the animated GIF files you create.

Keep in mind that animated GIF files created with Animation Wizard can subsequently 
be edited in the main window of GIF Construction Set.

Note that Animaton Wizard will allow you to import images from most popular 
bitmapped file formats. You will enjoy much better results if you import your source
images from a  24-bit format, such as BMP, PCX, PNG or JPG, rather than from 
GIF files. Note also that Animation Wizard only imports images -- it does not 
include transparency information from your source files.

Using Animation Wizard
The Animation Wizard feature of  GIF Construction Set for Windows will walk you 
through creating an animated GIF file. It offers fewer options than you'd have if you were
to create an animated GIF file from scratch, but it's dead easy to use. It will prompt you 
for information about the animation you want to create, assemble all the necessary blocks
and finally open the file in GIF Construction Set's main window. You can edit it further, 
or just save it to disk.

To create a GIF file with Animation Wizard, simply select this feature from the File menu
of GIF Construction Set for Windows and follow the prompts. You can fine tune your GIF
file after it has been created by Animation Wizard. The most important questions are: 

- Do you want to create an animated GIF file for use in World Wide Web Page?
If you answer Yes to this question, Animation Wizard will choose a palette for your 
GIF file which is optimally compatible with Netscape Navigator. 

- Are the images for your GIF file photorealistic or drawn?
Photorealistic images are scanned graphics and computer generated art which has 
gradients. Anything that looks as if it might have started life as a photograph should 
be regarded as photorealistic. Drawn images are graphics with hard lines, such as text 
and line art. Draw images with sixteen colours are text and line art which are 
constrained to use the default Windows palette, that is, graphics with very few 
colours.

The Match to Superpalette option of Animation Wizard will create a new optimized 



palette for your animation based on the palettes of all the source images you have 
selected. This will usually produce the best looking animations.

The Match to First Palette option of Animation Wizard will match all the colours in all 
the images you select to the palette of the first image. This will eliminate dithering 
problems when you assemble an animation from source GIF files as long as you choose 
the first image appropriately. Note that if the first image is a 24-bit graphic, its palette 
will be the current default palette, as selected in Setup.

Especially if you're new to using animated GIF files in a web page, it's a really good idea 
to start with Animation Wizard.

Creating Animated GIF Files by Hand
You can create animated GIF files by hand in GIF Construction Set for Windows – this 
approach is more time consuming, but it will give you more control over how your 
animated GIF files look and behave.

It's also noble as hell, of course – hard stuff always is.

Here's how to do it:

1. Check the Setup dialog to make sure you have an appropriate default palette. For 
animated GIF files to be used on the web, this should be either the sixteen-colour 
Windows palette or the 216-colour Netscape palette. Other palette options will work, but 
they may produce less attractive images in a web page viewed on a 256-colour system.

2. Select New from the File menu.

3. Click on Insert and select Image.

4. When the Open dialog appears, select the image files that will appear in your 
animation. You can select more than one file at a time by holding down the Ctrl key and 
clicking on each file in turn, or by selecting the first file to be part of your animation, 
holding down the Shift key and then selecting the last file. Click on OK when you're 
done.

5. When the Palette dialog appears, select Dither to Global Palette if your source images 
are photorealistic or Remap to Global Palette if they're drawn. Enable the Use This 
Selection for Subsequent Images item. Click on OK.

6. When all your images have been inserted, click on Insert and select Loop if you want 
your animation to loop continuously. Note that as of this writing, the Iterations counter of
a Loop block is ignored by Netscape. All animated GIF files with Loop blocks will loop 
forever.



7. You must insert a Control block in front of each Image block in your GIF file. The 
easiest way to do this to select Manage from the Block menu. Click on Select All and 
enable the Insert Before Selected Images item. Click on Apply. A dialog will appear to let
you set the parameters of your new Control blocks. 

You should set a Delay value – this varies with the intended speed of your animation. 
Netscape's animation drivers are a bit machine-dependent as I write this – absolute speed 
settings are largely impractical. Start with something around 100. You can change this 
later with the Manage function.

If you'll have transparent elements in your GIF file, you should set them now, as 
discussed elsewhere in this document.

The Remove By option should be set to Nothing if your GIF files are all the same size, 
have no transparent elements and will overlay each other perfectly, or to Background 
otherwise.

Click on OK when you're done.

8. Your animated GIF file is complete. Click on View to see what it looks like, and on 
Save As to save it to disk. Note that Netscape's animation playback runs at anywhere 
from five to ten times faster than real time – as of this writing, it's usually necessary to 
make animated GIF files run artificially slowly under GIF Construction Set to get them to
run at something like the right speed in Netscape. Also note that the Background value in 
the Header block of your GIF file defines the background colour for the View feature 
under GIF Construction Set – it's ignored by Netscape.

Secrets, Tricks and Common Applications
Here are a number of useful things you might want to know about using GIF 
Construction Set for Windows.

Animated GIF files: As of this writing, Netscape's command of multiple-image GIF files
has a few catches. Here are some of the ones you might want to keep in mind:

- The iteration count in Loop blocks is ignored by Netscape 2.0, although it appears to
work in the 3.0 Atlas beta. Your animations will loop forever under 2.0 no matter 
what value you put in this field.

- Animations are supported by versions of Netscape 2.0 or better and versions of 
Microsoft's Explorer 3.0 or better. No other browsers we know of supports them as of 
this writing.

- If any of the cells in your animation extend outside the rectangle defined by the 
Screen Width and Screen Depth field in the Header block of your GIF file, Netscape 
will more than likely crash. The Adjust header on Save feature of GIF Construction 



Set will prevent this from happening if you leave it enabled.

- Netscape 2.0 pauses momentarily at the end of an animation sequence before it 
loops. There's nothing you can do about this.

- Netscape does not implement Wait for User Input or Remove by Previous Image as 
of this writing.

- A web page with animated GIF file on it will never be "done" in Netscape – that is, 
the Stop button will always be active.

Creating transparent GIF files: A transparent GIF file is one in which an image block 
displays with one transparent colour. Anywhere the transparent colour exists in the image,
no pixels will be painted and whatever was visible before the image appeared will show 
through. To create a transparent GIF file, add a control block before the image block you 
wish to include transparent areas. Enable the Transparent Colour switch in the control 
block and set the transparent colour to correspond to the colour of the areas of the image 
you wish to appear transparent. 

Here's the complete procedure, step by step:

1. Open a GIF file. You should have a Header block and and Image block visible in GIF 
Construction Set.

2. Click on the Header block once.

3. Click on Insert.

4. Click on Control. You should now have a Header, a Control and an Image block.

5. Double-click on the Control block to edit it.

6. Enable Transparent colour.

7. Click on the eyedropper tool and use it to select the colour in your image that you want
to be transparent.

8. Click on OK and save the file. 

Note. Read this. Very important. Definite demon bait if you don't. Transparent GIF files 
only display with their transparent elements under fully compliant GIF viewers. This 
includes GIF Construction Set for Windows, most World Wide Web Browsers and a 
limited number of other GIF viewing applications. Most applications that just display 
pictures will ignore transparency  information in GIF files. This includes our own 
Graphic Workshop software, for example. If your transparent GIF files don't seem to be 
transparent in some applications, the problem is not with GIF Construction Set for 



Windows or your GIF files. 

Creating Interlaced GIF files: This one's easy. Open your GIF file and edit its Image 
block. Enabled the Interlaced option and save the file.

Creating magic graphic logos: You can create a GIF file that has a main image and a 
smaller secondary logo which appears, sticks around for a moment and goes away. In 
addition to the main image block, you will need a control block followed by a smaller 
secondary image. The secondary image can have a transparent background... this looks 
very slick. Set the control block up with whatever transparent colour you require, a brief 
delay, the user input flag turned on and the Remove By field set to Previous Image.

Creating plain text with a drop shadow: This looks very slick. It involves two plain 
text blocks and two control blocks. Each of the plain text blocks should contain the same 
text. The second one should be slightly lower and to the right of the first one... two pixels 
in each direction is usually about right. The second and optionally the first plain text 
block should be set up so their background colours are transparent, as defined by their 
control blocks.

Automatically viewing an image when it's loaded: Hold down the shift key when you 
double click on a GIF file name in the main application window of  GIF Construction Set
for Windows and the image will be loaded and then immediately viewed.

Using GIF Construction Set for Windows as a GIF viewer for other applications: If 
you run GIFCON.EXE, the executable file for GIF Construction Set for Windows, with 
the path to a GIF file as its command line argument, it will automatically load the 
indicated file just as if you'd explicitly loaded it by clicking on it from the main 
application window. If you append /V to the file name, it will automatically load and 
view the file. If you append /V/Q to the file name, it will load the file, view it and then 
quit back to the calling application as soon as you hit Esc or click with the right button of 
your mouse. You can prevent it from quitting in this situation by holding down the shift 
key when you exit the view mode. 

GIF Construction Set for Windows makes a powerful GIF viewer for World Wide Web 
browsers.

What Became of Bookware?
Users of earlier versions of GIF Construction Set will note that it used to be offered as 
bookware. The registration "fee" was to buy and read Steven William Rimmer's novel 
The Order. Beginning with version 1.0h, GIF Construction Set became conventional 
shareware.

There are several reasons for this,  not the least of which is that what started out as an in-
house gadget has become a fairly complex application with the advent of the widespead 
use of GIF files on the World Wide Web. Users of GIF Construction Set have asked for 



new features in the package – animation support, for example – which required time to 
implement. Bookware wasn't paying for the development required to keep GIF 
Construction Set up to date and up to everyone's requirements of it.

If you have registered an earlier bookware copy of GIF Construction Set, this shareware 
version will be registered as well. You need not pay an update fee to use the new features 
in the shareware release of this package. It's a really good idea to write down your 
registration name and key word, however, as the GIF Construction Set Setup box won't 
prompt you for a page reference from The Order any longer. The quickest way to find 
these is to open \WINDOWS\GIFCON.INI with a text editor.

Contacting Alchemy Mindworks Inc.
You can contact us by snail-mail by writing to us at:

Alchemy Mindworks Inc.
P.O. Box 500
Beeton, Ontario
L0G 1A0
Canada

We will attempt to answer questions from unregistered users who write
to us to the extent that their answers are needed for you to fully 
determine whether this software will suit your requirements. 

You can reach our technical support line by phone... see the section of 
this document which deals with technical support.

We can also be reached through the Alchemy Mindworks bulletin 
board. It's available twenty-four hours a day at 1-905-936-9503. As of 
this writing, the protocol was 300, 1200 or 2400 baud, or 9600 or 
14,400 baud v.32bis, eight data bits, no parity and one stop bit. 

The bulletin board always has the most recent versions of all our 
shareware on it, plus bug fixes, drivers and other relevant information. 
It only exists to support Alchemy Mindworks' shareware... it does not 
have a general file area.

If you encounter problems with a file, you're welcome to upload the 
errant file to our bulletin board. Actually, you can upload any picture 
files you like to the board... we enjoy getting pictures.

Our CompuServe address is 70451,2734. Our Internet e-mail 
address is alchemy@mail.bconnex.net. We will at our discretion answer
reasonable questions by e-mail. Please do not leave credit card 
information on the Internet.



You can find the current version of GIF Construction Set for Windows and our 
other applications on the Internet at our FTP site 
ftp.mindworkshop.com in the directory /pub/alchemy.

You can download current versions of our applications, keep up to date 
with version changes and find other interesting bits at our World Wide 
Web server http://www.mindworkshop.com

We ask that in contacting us you appreciate that we are a small 
company with limited resources. If you have not registered this 
software we will not tell you to go to hell, but please don't ask us for 
half an hour of free technical support. We have not built the price of 
technical support into the cost of GIF Construction Set for Windows, as few 
users require it. We believe very strongly in not making everyone pay 
for something that only a small group needs. If our various 
governments felt the same way, our various economies wouldn't be in 
the midst of melting down.

Support this Software
If you like GIF Construction Set for Windows and find it useful, please register
it. This will allow you to shut off the begin notice which appears when 
you exit GIF Construction Set for Windows. More to the point, though, it'll 
make you feel good. We've not infested GIF Construction Set for Windows 
with excessive beg notices, crippled it or had it verbally insult you after
ten days. We trust you to register this software if you like it.

If you want to see additional features in GIF Construction Set for Windows, 
register it. If we had an Arcturian mega-dollar for everyone who has 
said they'd most certainly register one of our applications if we'd add 
just one more thing to it, we could buy ourselves a universe and retire.

Finally, as mentioned at beginning of this file, should you fail to register
this software and continue to use it, a leather-winged demon of the 
night will tear itself, shrieking blood and fury, from the endless caverns
of the nether world, hurl itself into the darkness with a thirst for blood 
on its slavering fangs and search the very threads of time for the 
throbbing of your heartbeat. Just thought you'd want to know that.

Technical Support
Technical support is available at 1-905-936-9501, 10:00am to 5:00pm 
EST most business days. If you encounter our answering machine... it 
does happen occasionally... please try back later. One of the 
considerations in offering very low cost software is that we are



unable to return calls for technical support.

Callers who are rude, abusive or pig-headed with our technical support 
staff will wind up as demon-chow. See the section on Registration 
elsewhere in this document.

Please do not call our 800 number for technical support. The 
people who answer our sales line can put a credit card machine
into warp drive, but they know less about software than most 
cats know about quantum mechanics.

We are also happy to provide you with technical support by e-mail, as 
discussed earlier in this document.

Bundling GIF Construction Set for Windows 
If you'd like to include GIF Construction Set for Windows with your product, 
please get in touch with us. We have several ways to help you do this 
so your users get the most out of our software and we won't have to 
set our leather-winged demon of the night on 'em.

Notes for Shareware Distributors
Please see the Shareware Distribution document included with GIF 
Construction Set.

Revision History
1.0Q - Added a Paint function to the Image block editor (32-bit only). 
This hooks a paint program, Windows Paintbrush by default. Added 
match to Superpalette in the Animation Wizard. Added teletype and 
texture effects to Banners. Added more flexible memory management 
for block allocation. Added LEFT and TOP subcommands to the IMAGE 
command in script mode. Added superpalette options to the Movie to 
GIF function. Added a quick AVI preview. Added GIF to Movie. Added a 
Spin option for two-dimensional rotation. Added Colour and Balance. 
Added more detailed information to the main block list -- and a switch 
in Setup to turn this feature off. Fixed a bug in supercompressor. Added
Extract to Numbered Files to the Extract function.

1.0P - We skipped version O for reasons of sanity at the technical 
support desk -- the question "which version are you using" seems to 
elicit suffient confusion as it is. Added Image Strips. Added LED Signs. 
Added a file identification option. Improved wide palette GIFs with 
fifteen-bit quantization and wide palette dithering, something to behold
if you're not in a hurry. Added more text effects to the Banner function. 



Added a trap for zero-length comment blocks, which were causing 
some "corrupted file" messages. Totally rewrote the file import filter 
interface, which affects how files are read for Animation Wizard and 
Insert Image. Hopefully this will both speed up file reading and 
eliminate the remaining mystery file corruption messages. Added 
palette editing to the Header and Image editing dialogs. Updated the 
32-bit build to use the Explorer-style file dialogs -- gag me with a 
spoon. Added supercompression. Added Match to First Palette in 
Animation Wizard. Added palette compression to the effects. Added flip
and rotate to the Block menu. Fixed a bug in the AVI to GIF converter 
that plagued some sixteen-bit AVI files. Fixed a bug in the Image Strip 
function. Added scaling. Added cropping. Added scripting. Added drag 
'n drop 'n fluff  'n fold. Added an option to write uncompressed GIF 
files.

1.0N - Added movie to GIF conversion. Fixed some string table 
problems. Improved the timing features. Fixed a display problem in 
View mode. Added Image block positioning to the Manage dialog. 
Added keyboard accelerators to the dialog boxes... tres retro. Added 
multiple file selection to Animation Wizard. Added a Frequently Asked 
Questions document to the GIF Construction Set package. Added wide 
palette GIF files, to support more than 256 colours and break the laws 
of nature.

1.0M - Made GIF Construction Set compatible with Windows NT -- it 
doesn't sound like much here, but t'was a mighty battle. Fixed a bug in 
the GIF import filter. Fine tuned the Animation Wizard.

1.0L – Added a feature to check for animations which might upset 
Netscape. Added a feature to adjust the header screen width and 
screen depth automatically on Save. Added a feature to check for 
Netscape-incompatible animations on Save. Added a banner generator.
Added an animated transition generator. Added an Extract feature. 
Added block management. Added an animation wizard. Added more 
default palette options. Cleaned up some Windows cosmetic issues.

1.0k – Fixed a number of really strange compiler oddities in the 32-bit 
build – by changing compilers. Back to Borland C++. Note that this 
only affects the 32-bit version – there is no 1.0k build for the sixteen-
bit version.

1.0j – Fixed a memory leak in view mode. Released the 32-bit build.

1.0i – Fixed a bug in the palette dialog.

1.0h – Improved the colour dithering. Added a default colour depth 



item to Setup. Modified the New function to automatically install a 
default palette. Fixed a bug in the JPEG import function. Added multiple
image importing. Fixed a bug that made some animation unstoppable. 
Added block titles. Bade a sad farewell to bookware.

1.0g – Added looping.

1.0f – Added true transparency. Added a feature to remember the 
directory GIF Construction Set was logged into when it last terminated. 
Fixed a bug that made it disappear from time to time under Windows 
95. Added an Export function.

1.0e – Fixed a DLL conflict.

1.0d – Added PNG support for the file import function. Generally tidied 
things up under Windows 95. Added an option to display interlaced 
images in interlaced order. Fixed a bug that caused GIF Construction 
Set to create illegal four- and eight-colour GIF files. Added an 
eyedropper tool to the plain text and control block dialogs.

1.0c – Fixed a problem that caused transparent monochrome GIF files 
to display incorrectly on some displays. Added spin buttons to some of 
the dialogs. Fixed a problem with setting colours in the plain text dialog
after viewing. Added a version display for unregistered copies.

1.0b – Fixed a bug which caused some GIF files to appear to only have 
two colours, when in fact they had complete palettes.


